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Screen Layout
This section of the manual is intended to overview the components of G-ZERO Conversational CAM
System for Mills main screen.  Detailed information on specific features is covered in later sections.

Title bar
The title bar extends across the top of the application window, and displays the name of program as well as
the name and path of the current source file.  The three buttons located at the right end of the title bar allow
you to  minimize,  maximize (or  restore), and  close the window.  Closing the window will exit
G-ZERO Mill.
Place cursor on title bar and:

double-click the left mouse button to maximize or restore the window
click (left mouse button) and drag mouse to relocate the window (windows should not be maximized)
right-click (click right mouse button) to display right mouse list box with these commands: Restore,
Move, Size, Minimize, Maximize, and Close (Alt+F4)

Programming / Editing area
This is the largest section of the G-ZERO Mill application window that displays the contents of your current
source file.  (Note that you need to Save your file before the displayed source code is actually recorded in
your source file).
When the information on the programming area needs a larger display area, a vertical and/or horizontal
scroll bar(s) will appear at the side and/or bottom of this section.  Use your mouse to click the scroll arrows
(at the end of the scroll bars) or click and drag the scroll box to move around the programming area and
display the overflowed sections.  Only one source file can be opened at a time.
The background color of the programming area as well as the font style and size can be adjusted in the
Tools | Options | View window.
The Programming area is also the place where source code editing is done.

Title bar (with file name and location)

Menu bar (pull-down menus)

Commands menu

Dialog bar

Status bar (with suggested speeds)

Programming / Editing area

Code building area

Viewport
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Menu bar
G-ZERO menu bar contains the following pull-down menus:

Use mouse to select an option from the menu bar.  When the menu drops down, click on the command you
want.
You can also use keyboard to make your selections.  Press and hold the Alt key and key in the character that
is underlined (e.g.: Alt+F+S for File | Save).  Once the menu has dropped down, you can also use the
keyboard arrow keys to make your selections and press the Enter key when your choice is highlighted.
A shortcut is available for commands most frequently used.  Function keys or shortcuts are listed on the
drop down menus.

Commands menu
G-ZERO Mill currently has 38 programming commands (#18 and #28 are not available) and they are listed
on the left side of the application window.  Use the scroll bars to display the rest of the commands.
To call (or use) a command, place your mouse cursor on top of the command icon or description you want,
and click the left mouse button.  You can also use the keyboard numbers (or 10-key pad) to call a command
by typing the number that correspond to the command you want (shown before the name of the command).
Example: keying in 1 has the same effect as using the mouse to click on the POINT command.
G-ZERO Mill normally displays the full command menu (icons and name); however, you have the option of
displaying just the icons or no commands at all.  The advantage of reducing the visibility of the commands
menu is that it frees monitor space to increase the programming area.  To adjust the size of the commands
menu, place your mouse cursor on the right side of the commands scrolling bar until the cursor changes to a
double arrow ; at this point, hold and drag it to the left or right to respectively reduce or increase the
display of the commands menu.  You can also, select (or unselect) Full menus from Tools | Options | Views.
G-ZERO disables (shows in gray) the commands that are not logically needed.  The beauty of this feature is
that it can guide new G-ZERO programmers in the proper sequence for programming.
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Code building area
Each source code line is built in this area.  Each time a programming command is called, a new line number
and command name will appear on this bar.  Commands parameters are also sequentially  displayed here as
the command is being formed.  Once the entire command line is created, the source line will be transferred
to the programming area.
Example of complete command line: 8  POINT  x.6y3f20

Dialog bar
This is the section G-ZERO uses to display the questions that will assist you to create a source line.
Example:   When you first start a program, the dialog bar displays:

Please select the option you would like and then press ENTER.

When the POINT command is called, G-ZERO will immediately ask you the first question and waits for
your answer to the first parameter value:

WHERE, IN X WOULD YOU LIKE TO POSITION THE TOOL?  0.6

You will notice that a default value is suggested by the program.  This value is the last number entered to
answer that specific question.  If you accept that number, just press the ENTER key.  If you need another
number, just key in your new value.
After you enter the answer to the first question, the second question is displayed in the dialog bar:

WHERE, IN Y?  3

Again, the default value is displayed and G-ZERO waits for your reply.  After you press ENTER, the last
question will be asked:

MOVE TO THIS POINT AT WHAT FEEDRATE? (0=rapid)  20

After the last answer is keyed in, G-ZERO transfers the entire source line from the code building area to the
programming area.  G-ZERO will now wait for your next instruction:

Please select the option you would like and then press ENTER.

Status bar
The status bar extends across the bottom of the G-ZERO application window, and displays valuable
information.  Some of these information really help you decide for the most appropriate answer to the
question displayed in the dialog bar.  Examples of data displayed on the status bar are:
4.781, -2.041 . mouse cursor coordinates (only when mouse cursor is within the viewport display)
s60 S917 ...... s60 means 60 surface feet (G-ZERO calculates it using PartMaterial.S file based on

the tool type and tool size)
S917 means 917 rpm (G-ZERO calculates it using the surface feet and tool diam-
eter)

ZF=136.1 ...... Z feedrate (G-ZERO calculates it using the chipload listed in PartMaterial.S file
based on the tool type and tool size)

XYF=1.8 ....... XY feedrate (G-ZERO calculates it using the chipload listed in PartMaterial.S file
based on the tool type and tool size)

xff1.58=2.8 ... recommended feedrate (base feedrate x feed factor)
1:52PM ........ current time (taken from computer clock)

line number
command
3 parameters
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Dialog Boxes (from Tools | Options)

Viewport
G-ZERO uses the viewport to display the graphical representation of the current source file in various
formats (e.g.: solid view, wireframe, wireframe with tool path, etc.)
The viewport can also help you verify or debug a source program.  Use your mouse to click on any section
of the graphic displayed on it, and G-ZERO will find and highlight its corresponding source code in the
programming area.
This viewport window can be resized and placed at any location on your computer screen, even attach it to
the G-ZERO application window.
(See the Viewport section of this manual for more details.)



REFERENCE Basics      9

Preferences
Command Menu
You have the option of displaying full menus (icons and descriptions), or just icons.  To switch from one
option to the other, select (or unselect) the Full Menus check box in Tools | Options | View window.

Color and Font
You can customize the background color as well as the text font and size of your programming codes.  To
do this, make the desired changes in the Background Color and Fonts section in the Tools | Options | View
window.

G-code Text Editor
G-ZERO uses the assigned Text Editor to open the G-code file right after it is created through the

 20) POST command (F12).

Setup the G-code text editor you like in the Tools | Options | File Location window.  The default editor is
Windows Notepad.

Metric / Inch System
To program in Inches (output in inches):

Metric check box (Tools | Options | General) needs to be unselected.
Ctrl+M (input a millimeter value and let G-ZERO convert it to inches).
Example:  key in 1 (mm) followed by Ctrl+M to have that number converted to 0.03937 (in)
Ctrl+Shift+M (input an inch value and let G-ZERO convert it to millimeter).
Example:  key in 1 (in) followed by Ctrl+Shift+M to have that number converted to 25.4 (mm).

To program in Millimeters (output in millimeters):
Metric check box (Tools | Options | General) needs to be selected.
Ctrl+M (input an inch value and let G-ZERO convert it to millimeters).
Example:  key in 1 (in) followed by Ctrl+M to have that number converted to 25.4 (mm).
Ctrl+Shift+M (input a millimeter value and let G-ZERO convert it to inches).
Example:  key in 1 (mm) followed by Ctrl+Shift+M to have that number converted to 0.03937 (in).

Source Header - startsrc.org
If you would like a series of comment lines to pop up at the start of every new source program, create a text
file named STARTSRC.ORG with the information you want (e.g.: part number, customer name, date,
programmer name).  Example:
  1. Create text file startsrc.org

Use Notepad (Start | Programs | Accessories | Notepad) to store the information you like such as:
P/N:
CUST:
DATE:
Save this file to the Mill directory (e.g.: C:\MILL) using the file name STARTSRC.ORG
(Make sure that the file name has extension ORG rather than TXT)

   2. Register location of startsrc.org in G-ZERO
From G-ZERO’s Tools | Options | File Locations use second Browse to locate the directory where you
saved startsrc.org  (e.g.:  C:\MILL).  Click Apply and OK to save settings and close Options window.

   3. Start new source program / Use Source Header
Open new source program (File | Open and type new file name).  Fill in comment lines if applicable.
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File Management
Open

Start a new source file by typing a new filename in the Source File to Open window (File |
Open).  Since the file does not exists, G-ZERO will start a new source file.
Open an existing source file by selecting it from the Source File to Open window (File |
Open).  Make sure that the lower section of this window (file type) is set to display G-ZERO
Mill source files (extensions .m)
Open an existing G-code file by selecting it from the Source File to Open window (File |
Open).  Make sure that the lower section of this window (file type) is set to display G-code
files (extensions .t).  G-code files are opened with the default text editor.  To change the
default text editor, go to Tools | Options | File Locations windows and use the Browse button
to setup the link to the new text editor.

Incremental search - WinLauncher
Launching files through WinLauncher allows you to use
the incremental search method: type the first letter(s) of
your filename to narrow down your search by displaying
only the filenames that meet your search requirements.
If you have taken a snapshot (see Viewport section) of your
files, these pictures can help you search for the file you
want to work on.

Save
Save your current source file by clicking the Save option from the File pull-down menu (File | Save).  By
default, G-ZERO Mill v4.0 automatically saves every three minutes.  (This can be adjusted on the Save
screen from Tools | Options menu.)

Save As
Save As creates a new file with the current information (duplicates
the current file).  If the current file has changes that were not saved,
G-ZERO will prompt you to save the changes before closing the
current file and starting the new file.  Enter a new file name (you can
change the drive/directory if you want).
After entering the new file name, G-ZERO prompts you 3 options:
Copy.  The new file has the exact same information as the current
file.
Rotate.  The new file has all data from the current file rotated at a
certain degree and/or shifted in the x axis and/or y axis.  Note:  Open
rotated file and use 26)UnEdit/Recalc to update G-ZERO auto-
calculated values before posting.
Mirror.  The new file has all data from the current file mirrored
based on the x or y axis depending on your selection.  Note:  Open
mirrored file and use 26)UnEdit/Recalc to update G-ZERO auto-
calculated values before posting.
The new file is going to become the new current file.  (Check the
new file name and/or location displayed on the upper left corner of
your G-ZERO main window)
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Backup
Backup the current file into a floppy disk by selecting the Backup option from the File pull-down menu
(File | Backup).  A backup file is an exact copy of the current file.  The current file remains active.
To change the default backup disk drive (A:), make the appropriate selection in the Save screen from Tools |
Options.

Merge Sources
Creates a new file named smerge.m with
the source of the current file plus one or
more files of your choice.  After the
Merge source programs window appears,
select one of the 4 options listed.
Note 1:  You need to have one source
file opened before invoking the Merge
Sources command.
Note 2:  After merging files, the smerge.m file becomes the active file.  It’s highly recommended that you
rename this file to avoid overwritting the information the next time you perform another merge.

Export Macro
Create a macro file with a portion of the current source file by
selecting the Export Macro option from the File pull-down
menu (File | Export Macro).
After typing a new file name (for the macro file) in the Save As
window, a new window pops up to allow you enter the sequence
of source lines you want included in the new macro file.
Macro files are text files with default file extensions .U.  They
can be imported into a source file with the # commands.

Delete
Delete the current source file by selecting the Delete option from the File pull-down menu (File | Delete).

Close
Close the current source file by selecting the Close option from the File pull-down menu (File | Close).  You
can also click on the X button in the upper right corner of the application window (Title bar).

Print
Print entire source file
Send the current file directly to the default printer by selecting the Print option from the File pull-down
menu (File | Print).  To change the default printer, select Start | Settings | Printers from Windows taskbar
(usually at the bottom of your screen), and select the Set As Default options in the right-click list of the
printer you want to set as default.

Print from/to
To print only a section of your source code, use the PRINT command.  G-ZERO will ask you to enter the
first and last line numbers of the source codes you want to print.

Print tool list
To print only the lines that correspond to the TOOL command, select File|Print|Print ToolList.
Or, use the  command and print from line -1 to line 0.
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Programming
Source Programming

G-ZERO is a Source Based Programming software that thinks the way a machinist thinks.  You type in
commands using exactly the same logic your CNC uses.

Programming Sequence
First, start with the Material command (Mat’l).  G-ZERO asks you several questions to guide you in

providing the dimensions and type of material you are going to use.  It’s conversational!
Second, program the Tool command.  Again, G-ZERO will ask you several questions about the tool such as

diameter, number of flutes, bull nose radius, and spindle speed.  Whenever you need to answer a
question about speed, G-ZERO will do some calculations and prompt you a suggested speed on the
status bar.

Third, program a cutting operation such as drilling (Drill&Tap), or milling (Mill).  Once again, just
answer the questions G-ZERO has for you about your cutting tool and depth of cut (Z value).

Finally, program the geometry commands (e.g.: Point, Radius, Line, etc.) to tell your CNC the location of
the cut.  Just answer the questions about the X and Y values!

Repeat lines
Click source line number to instantly call the REPEAT command  from that line.
Example: - Click on line number 22

- G-ZERO calls the command REPEAT:
REPEAT  from22 thru

- Click on line number 27
- G-ZERO completes programming the command:

REPEAT  from22 thru27

Collapse/Expand lines
Ctrl+LeftArrow.  Collapses source program hiding all lines except for the Material and Tools commands.
Line numbers will be preceded by a double arrow symbol ».  Note:  If source lines from some Tools were
previously made visible, they are not going to be collapsed.
Ctrl+RightArrow.  Expands the entire source program to its fully visible condition.
Click on double arrow ».  While in collapsed condition, use your mouse to click on a double arrow » to
display all lines from that Tool.  Visible lines (while in collapsed condition) are shown with a dot · in front
of their line numbers.  Press any Redraw function key (F2 - F6) to view a graphical representation of only
source lines shown.
Click on dot ·.  While in collapsed condition, use your mouse to click on any dot symbol · to collapse that
Tool back down again and hide its source lines.

                    



REFERENCE Basics      13

Source Editing
Change a value
To change a value in a source program, use your mouse to click the value you
want to change, type in a new value to replace the one that is highlighted.  The
background of the editing area turns to blue when you are in editing mode; press
the Enter key to save your changes and exit editing mode.  Press Escape to
leave it unchanged.
Note:  To edit a comment, just click on the comment to access the editing mode.
Use Backspace and Arrow keys to assist your editing.  Press the Enter key
when done, or Escape to abandon editing.

Change sign
To change the sign of a value, use your mouse to click (left mouse button) the value to which you want to
change the sign, right-click (right mouse button) the just highlighted value to change its value from positive
(+) to negative (-), or negative to positive.  Press the Enter key to exit editing mode.

POINT to RADIUS type2
Press and hold the Alt key and use your mouse to click on a POINT command to convert it to a RADIUS
type 2 (corner).  This is a nice help to clean up CAD data.

RADIUS type2 to POINT
Press and hold the Alt key and use your mouse to click on a RADIUS type 2 command to convert it to a
sharp POINT.

LINE (unknown angle <<<<< known angle)
Press and hold the Alt key and use your mouse to click on a LINE command with unknown angle to
convert it to a LINE command with known angle.

RADIUS (type0 unknown radius <<<<< type1 known center)
Press and hold the Alt key and use your mouse to click on a RADIUS type 0 command (unknown radius)
to convert it to a RADIUS type 1 command (known center).  Note that there is no “undo” for this proce-
dure, but you can always manually change type “1” to type “0” (the x and y values in parenthesis will be
ignored by G-ZERO for all RADIUS type0)

Search source line using Viewport
Click on any wireframe or solid parts in the viewport  (walls or floors) and G-ZERO will highlight the
related command line in the source program.  If you see that the viewport shows a graphic that doesn’t seem
correct, click on the questionable element to locate the line code that needs to be changed.

Purge file
Most “deleted” lines in G-ZERO are actually just hidden, and not permanently deleted.  The Purge option
(from the Edit pull-down menu) permanently removes all such lines from the source program.  After a file is
purged, all line numbers will be automatically re-sequenced.

Find - Find Next
Find.  Use Ctrl+F or Edit | Find to locate the first value (or strings of values/characters) within your active
source code.
Find Next.  Use Ctrl+S or Edit | Find Next to locate the next appearance of the value (or strings or values/
characters) previously searched using Edit | Find.
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G-code
After programming your source, G-ZERO can regenerate your entire part program in precisely the language
your CNC understands.  Rapid Output customizes your post processors so your time is spent making good
parts, not editing tedious G-code.

Generate G-code
You only need two simple steps to generate G-code:

F12.  Press F12 (or Tools | Post Process, or 20) Post) to open the Tool Post Selection window.  (Note
that post processors are customized and sold separately)
Post.  Select a tool post (for example: FADAL) and watch how G-ZERO creates the right G-code for
the machine selected.  G-ZERO also saves the G-code file (extension .t) and displays it on your screen
using Notepad (or your default G-code Text Editor)

To change your default G-code Text Editor, click on the Tools | Options menu, and select the “File Loca-
tion” dialog box.  On the “Text Editor” section, assign the program you would like to use as the default text
editor.

Open G-code file
Select File | Open from the G-ZERO application window.  In the “Source File to Open” window, make sure
to display “G-code (*.T*)” type of file in the “Files of type” option at the bottom of the window.
Cancel the “Sent to CNC...” window if you don’t want to send it now;  G-code will be opened with the
default text editor (e.g.: Windows Notepad)

Post Processor Perfection
If you ever need to edit your G-code, DON’T DO IT!  What you need is to update your post processor, and
we can do it for you when you send us (via e-mail support@g-zero.com, fax 510-475-0483):

1. Print out of the incorrect G-code with clear instructions (e.g.: cross out codes you don’t need, or write
down those you need to add)

2. Source program (.m file) that generated the incorrect G-code and post (.p file)
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Pop-Up Boxes
Pop-up boxes add extra information to your computer screen to assist you answering G-ZERO prompts.
For example:  the 6th question for the command 17) MAT’L asks “What is the part made of?”  This
question appears along with a pop-up box that lists the numbers to key in that correspond to specific types
of materials.
Information from pop-up boxes are stored in text files in the MILL\DAT directory.  The default pop-up
boxes are:
File name Command Question # Sample contents

17.6 17) MAT’L 6 Type of materials  (e.g.: 303 STAINLESS)
6.4 6) TOOL 4 Type of tools  (e.g.: CARBIDE MILL)
8.1 8) DRILL 1 Drill Cycles  (e.g.: C’DRILL)

81.4 8) DRILL 4  for 81=C’DRILL Standard number of pecks or peck distances
82.4 8) DRILL 4  for 82=C’SINK Countersink diameters or seconds of dwell
83.4 8) DRILL 4  for 83=PECK Number of pecks or depth per peck
84.4 8) DRILL 4  for 84=TAP Threads per inch
15.3 15) REPEAT 3 Reminder of value substitution option

Edit Pop-up Boxes
If the standard pop-up boxes do not contain exactly what you need, the information can be changed.  For
example, if you have always used a countersink tool in slot 3, you may want to keep it that way and change
the pop-up box.  To edit the information in a pop-up box, use a text editor such as Windows Notepad.
Example 1:  You want to modify the pop-up box that appears when you are answering the 4th question from
command 6) TOOL.  Use Windows Notepad to open the file C:\MILL\DAT\6.4 and make your changes.
Note:  if you are using a word processing, make sure you always save the files as TEXT ONLY.
Example 2:  You want to delete the pop-up box that appears when answering the 3rd question of command
15) REPEAT.  Delete the file 15.3 located in C:\MILL\DAT.

Create Pop-up Boxes
To create a new pop-up box, you first need to know the command number and order of question in which
you want the pop-up box to appear.  This file needs to be a text file located in the C:\MILL\DAT directory
(assuming your Mill program is in your C: drive).  The file name is formed by two numbers separated by a
period.  The first number corresponds to the command number, and the second number represents the
sequence of the question.
Example:  You want to create a “reminder” to pop-up when you are answering the first question of com-
mand 15) REPEAT.  Using Windows Notepad:

1. Start Notepad:    Start | Programs | Accessories | Notepad
2. Type your message within Notepad.   Example:

To reverse the direction your cutter takes
along a surface, use repeat backwards.
Example:    FROM 14 THRU 10

3. Save your file using the appropriate name and location:
File | Save As
C:\MILL\DAT\15.1
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Feeds and Speeds
Feeds and speeds defaults are setup in separate files according to the type of part material.  The file name
should be the same as the text used in the pop-up box 17.6.  G-ZERO Mill system comes with the speed
files: ALUMALOY.S, 303.S, 304.S, 1018.S, and 4140.S.

FEEDS AND SPEEDS FOR ALUMINUM 6061-T6
7) MILL _
    0rpm             ***HSS MILL
         0   ,-350
    0zfeed
         0   ,-.0001
         .015,-.0003
         .031,-.0007
    0xyfeed
         0   ,-.0001
         .031,-.0002
         .062,-.0003
    6rpm             ***HOGMILL
         0   ,-400
    6xyfeed
         0   ,-.0005
         .125,-.0008
         .187,-.001
8) DRILL _
    0rpm             ***HSS
         0   ,-350
    0zfeed
         0   ,-.0001
         .015,-.0003
         .031,-.0007

The 7)MILL and 8)DRILL sections of this file contain sets of rpm, zfeed and xyfeed for the different types
of tools starting from 0.  8)DRILL section has no xyfeed info, of course.

Each tool type section contains the rpm, zfeed, and xyfeed for the different tool sizes.  Whenever a
zfeed or xyfeed section is missing, G-ZERO will take the values of tool type 0.  This saves you time in
having to duplicate all the information for similar types of tools.
Be sure not to have any blank lines or missing values in the file.
The number in front of rpm, zfeed, and xyfeed refers to the number of the type of tool (as listed in pop-
up menu 6.4)
The minus means that this value is to be calculated.
Enter the tool size (diameter) in sequence from small to large.
Separate the diameters and the speed/feed with a comma.
Anything on the right side of the 3 asterisks (***) is simply a comment for your reference.

Spindle speed in surface feet per minute
(positive value = rpm)

Tool type 6 (HOGMILL) as
shown in pop-up box 6.4

Tool type 0 (HSS MILL) as
shown in pop-up box 6.4

Anything after 3 asterisks (***) is comment
for your reference

If negative, post will calculate spindle
speed to maintain the surface feet

Tool type
(as listed in file 6.4)

List diameters in sequence
from small to large

Use a comma to separate tool diameters
and speeds/feeds

Z chipload
(positive value = feedrate in z movement)

XY chipload
(positive value = feedrate in xy movement)Tool size information:

HSS mills from .031 to .06199
HSS mills from .062 up

When Z chipload is missing, feedrate in z
movement will be taken from Tool 0
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Example 1: 7) MILL_
0rpm           ***HSS
         0     ,6000
        .125 ,5000
        .25   ,4800

In this example, we are telling the post that all tools of type 0 (HSS) from a diameter of zero up to a
diameter of .125 should run at 6000 rpm when you are milling.  Tools with diameter between .125 and .25
should run at 5000 rpm, and tools with diameter larger than .25 should run at 4800 rpm.

Example 2: 7) MILL_
1zfeed
         0     ,1
        .125 ,3.5
        .5   ,7

Here, we are tellling the post that when we are milling with tool type 1 (CARBIDE MILL) we want to
plunge in Z at 1 ipm (for tools smaller than .125), 3.5 ipm (for tools between .125 and .5) and 7ipm (for
tools larger than .5).

Example 3: 8) DRILL_
0rpm
         0     ,-350

These lines tell the post that it should calculate the spindle speed to maintain 350 surface feet for any sized
tool.

Example 4: 8) DRILL_
0xfeed
         0     ,-.0005
        .125 ,-.001

Here, we tell the post to allow .0005 chipload with very small drills (up to .125), and to use .001 chipload
with .125 drills and bigger.

Edit feeds and speeds
All feeds and speeds files (files with extension .S) are text files, so you can use any text editor such as
Windows Notepad to edit them.  Feeds and speeds files are located in the MILL directory.
Note:  Make sure not to leave blank lines or empty values in the feeds and speeds files.

New material - Create new feeds and speeds file
Whenever you introduce a new material (e.g.: Steel 5150), you need to:

1. Add new material to file 17.6 to update the pop-up box for 17) MAT’L command.  File 17.6 is
located in the MILL\DAT directory.
Example: if we want to call the new material “5150” and assign it the number 5, then just add the line
5=5150 to file 17.6.

2. Create speed and feed file with file name as shown in file 17.6 and extenstion “S” (e.g.: 5150.S).
New feeds and speeds file needs to contain the 7)MILL and 8)DRILL sections to include the new
feeds and speeds for all milling and drilling tools.
Note:  To simplify your work, use an existing file as a template:

- Chose an existing material similar to the new one you are adding (e.g.: Steel 4140).
- Duplicate the existing material file and rename it with the new material (e.g.: use Notepad to
  open file 4140.S and use File | Save As to rename it to 5150.S).
- Edit the tools, speeds and feeds values to suit your new material.
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Viewport
The viewport is a window independent from the G-ZERO application window.  Its size, location and display
can be adjusted through a right-mouse-button list box and a toolbar.  (To display the right-mouse-button
list box, place your cursor in the Viewport and click the right mouse button.)
Note:  Press the F7 function key to hide or display the viewport from the G-ZERO application window.

System
Move - (Undocked) Your mouse cursor will change to a four-arrow icon  (cursor needs to be on
viewport), click and hold the left button of your mouse and drag the entire viewport to the location you
want.  This same action of dragging the viewport to a new location can be done by clicking the Move icon
from the toolbar.
Full Screen - (Undocked) Viewport will take up the entire screen of your monitor.  To go back to the
previous screen size, click the right button of your mouse, select System, and the option sizeable screen.
Show Editor - Hides the viewport and returns to the source code programming screen.  The same action
can be performed by pressing the F7 function key.
Dockable - If this option is selected, the viewport will be docked to the upper right corner of the source
code programming screen.  To undock the viewport, unselect the Dockable option from the System list.
Docking or undocking the viewport can also be done by clicking the Dockable icon from the toolbar.
Show ToolBar - Select this option to display toolbar at the top of the viewport.  To hide the toolbar,
unselect this option.
The toolbar can be detached from the viewport.  This is done by clicking on the gray area of the toolbar and
dragging it to another location.  To dock the toolbar to the viewport, drag the toolbar back to the top section
of the viewport.
Show Title - (Undocked) Select this option to display a title bar at the top of the viewport.  To hide the title
bar, unselect this option.  The title bar is also used to display the current Tool number during a simulation.
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Resize Viewport
Just like any Window, you can adjust the size of the viewport using your mouse.  Place your mouse
cursor on any edge or corner of the viewport to change the white arrow cursor to a double black arrow
pointed up and down  , or pointed left and right  , or pointed diagonally .  At this point, click and
hold the left button of your mouse and drag the edge (or edges if it’s a corner) of the window to increase
or reduce the size of the viewport.

Clear Screen
Select this option to clear any graphic currently displayed in the viewport.

Copy To ClipBoard
Once you click on this option, G-ZERO will automatically send the graphic currently displayed in the
viewport (without border and title bar) to the Windows Clipboard.  You can use another program (such as
Paint) to paste and print the image just captured.  (Note: For best results, set your computer color palette
greater than 256 colors)

Print View
Click on this option to send the graphic currently displayed in the viewport to your default printer.  Note that
printing with this option will include the black background.

Zoom
Zoom Out - Zooms out the current display; in other words, more (and smaller) graphic is displayed in the
same size viewport.  The keyboard shortcut is Ctrl+O.
Zoom In - Zooms in the current display; in other words, less (and larger) graphic is displayed in the same
size viewport.  The keyboard shortcut is Ctrl+I.
Zoom options NOT available through the right-mouse-button list box:

Zoom Window - Click (left button) and drag from one corner of the area you want to enlarge, to the
opposite corner.

Zoom Previous - To zoom to the previous zoom window, select  from the Zoom options pull-down
menu on the toolbar.  The keyboard shortcut is Ctrl+P.

Refresh - To restart simulation at the current zoom window, select  from the Zoom options pull-
down menu on the toolbar.  The keyboard shortcut is Ctrl+R.

Redraw
Part View   F2  - Redraws the entire source program without tool path.
Tool View   F3  - Redraws the entire source program and also shows the tool path.
Slinky Mode   F4  - Redraws the entire source program and also shows the tool path in slinky mode.
Iso View   F5  - Redraws the entire source program in isometric wireframe view.
Solid View   F6  - Starts the solid view simulation of the entire source program in the default solid view.
(See Solid Modeling / Simulator section).  Note:  Press the A key to stop simulation.
Single Step  - Redraws your entire source program one step at a time.  The source code programming
window highlights the line code it is simulating in the viewport.  Each time you click the left button of your
mouse (or press the space bar from your keyboard), the simulation advances one step (one line in the source
program).  Note:  Press the S key to exit the Single Step mode and finish the redraw in normal simulation
speed.  Similarly, press the S key while redrawing (wireframe or solid) to continue the simulation in single
step mode.
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Redraw options available ONLY through the Toolbar:
Left View - Starts simulation of the entire source program from its Left View.  Redraw will be done in
wireframe or solid mode depending on the last redraw command used.
Front View - Starts simulation of the entire source program from its Front View.  Redraw will be done
in wireframe or solid mode depending on the last redraw command used.
Top View - Starts simulation of the entire source program from its Top View.  Redraw will be done in
wireframe or solid mode depending on the last redraw command set.

Rotate
Click on this option to set a new view to display your graphic.  Your cursor will immediately change to a

“white hand”  icon (cursor needs to be inside viewport).  At this point, click and hold the left button of
your mouse and drag it to different locations to rotate your graphical representation to the view you want.
Release mouse button to start simulation.

The simulation (or redraw) will be done in wireframe mode if your last view was a part view  , tool view
, slinky mode , or isometric view .  The simulation will be done in solid mode if the last view was a

solid view .

SnapShot (with WinLauncher)
With a SnapShot (bitmap file), G-ZERO WinLauncher displays a graphic of the source file that is selected
from the Launch File dialog box.  In this way, you can see a graphical image of the source file selected
before you decide whether you really want to open it or not.
Note that your WinLauncher needs to be setup to use the “incremental search” method rather than the
traditional Windows 95, 98 search.  To do this, select the “Setup” hypertext from the WinLauncher main
menu, click on the “Options” tab, and select the “Incremental Search” method in the “File Dialog” section.

To take a SnapShot (Viewport of G-ZERO Mill), select the SnapShot  option from the  pull-down
menu in the viewport Toolbar.  Once you click on this option, G-ZERO redraws your image in order to take
a good SnapShot and it creates a Bitmap file using the same source name and extension BMP.  This bitmap
file is placed in the same directory as your source file.  (Note: For best results, set your computer color
palette greater than 256 colors)
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Solid Verification 
Simulation
With solid modeling displayed on your viewport, you can watch a simulation of your machining while you
are programming.  Any time you press , G-ZERO Mill v4.0 will instruct the simulation program to start
an animated representation of your entire source code.

         

Tool display
The tool can be shown in wireframe, solid shaded, and slow solid shaded modes.
To make any of these changes, select the appropriate option in the Default Solid Tool Type section of
Tools | Options | View screen.

Tool type
If you are using special tools and you want to show accurate solid modeling of these tools, you can include
the special commands %#TL, %#TT, and %#TA to control the length, taper, and angle of the tool shown.
Example 1:
TOOL 7 dia.25 flutes1 type30=C’SINK rad0 *** Deburr pocket with 1/4” csink %#TA=45
Example 2:
TOOL 1 dia.5 flutes4 type1=CARBIDE MILL rad0 *** 45 DEG DOVETAIL %#TL=.2 %#TT=-45
Example 3:
TOOL 2 dia1 flutes12 type1=CARBIDE MILL rad0 *** 3/16 THK WOODRUFF CUTTER %#TL=.1875
Example 4:
TOOL 6 dia.5 flutes4 type1=CARBIDE MILL rad.0625 *** %#TL=1.25 %#TT=5

%#TL=1.25

5º

%#TT=5

dia.5rad.0625

Woodruff Cutter
Dovetail Cutter Tapered

Endmill

Chamfering
Tool

45°

dia.25

%#TA=45

%#TL=.2

dia.5

%#TT=-45
45°

dia.1

%#TL=.25
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Solid View
There are nine preset Solid Views that can be set in the Default Solid View section of  Tools | Options | View
screen.

         

Iso 1 Iso 2 (v3.1 std.) Iso 3  Iso 4

            

Top Bottom Left Right Front

A quick way to display four of these views is done by selecting them from the Redraw option  in the
viewport’s toolbar:  Left, Front, Top, Isometric.  (Tool is displayed in wireframe or solid mode depending
on what was last redrawn)

Turbo Mode
Place a check mark in the Turbo Mode option (Solid Modeling Options section of Tools | Options | View) to
increase the speed of the creation of the solid representation.  Turbo Mode works in the background to
generate the solid view (without displaying cutting tool animation); so, you may notice a pause while
G-ZERO is doing its calculations.
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Input Math
We usually program our G-ZERO source codes entering values relative to the point of origin (0;0).  On the
other hand, most blueprints show dimensions in a different way, making it a little harder to get the values
you need for G-ZERO directly from your blueprint.  This is the reason why G-ZERO developers included
this input method through Math Calculation.
For example, if we want to mill the profile of the symmetrical part shown below, we need to know the
coordinates of 9 points (A through I).  Using point A as our point of origin (where X=0 and Y=0), our
source code will need the relative coordinates of the rest of the points (X and Y distance between point A
and the rest of the points).
Using the dimensions given in the graphic, we can calculate the relative coordinates of points B through I as
follow:

X Y

A 0 0

B -2.15 0

C -2.15 -2.1+1.25

D -.95/2 -2.1+1.25

E -.95/2 -2.1

F .95/2 -2.1

G .95/2 -2.1+1.25

H +2.15 -2.1+1.25

I +2.15 0

Operations and symbols
These are the symbols you can use when programming:

+ plus:  addition operation

- minus:  subtraction operation

* asterisk:  multiplication operation

/ forward slash:  division operation
\ back slash:  integer division operation
^ caret:  exponential (power) operation
( open parenthesis:  symbol used to indicate the start of a group

) close parenthesis:  symbol used to indicate the end of a group
= equal:  symbol used to display the result of the calculation before entering the value with the Enter

key
@ at:  symbol used to make the default value available as the first number in the calculation.  Example:

if you just drilled a hole at x=1.23 and you now want to drill a hole that is over .5506 from the last
hole, then enter @+.5506   (The key “@” saves you from typing “1.23” in the calculation)
right arrow:  0º
up arrow:  90º
left arrow:  180º
down arrow:  270º

‘ apostrophe:  converts degrees in dd.mmss format to decimals.  Example: if you need to enter
35º10’30” in decimal degrees, type 35.1030’ and G-ZERO will make the conversion: 35.175

“ quote:  converts degrees in dd.mmss format to decimal degrees. (Same as apostrophe symbol)

AB

C D

E F

G
H

I

R 2.15"

2.1"

.95"

1.25"
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Hierarchy
G-ZERO Mill v4.0 uses the same symbol hierarchy used in Algebra:

1st priority: ( )     G-ZERO allows unlimited number of nested parenthesis

2nd priority: *  / \
3rd priority: + -

Examples:
5.4-1.88/2 = 5.4-0.94 = 4.46

5.4-(1.88/2) = 5.4-0.94 = 4.46

(5.4-1.88)/2 = 3.52/2 = 1.76

2+3^2-5/2 = 2+(3^2)-(5/2) = 2+9-2.5 = 8.5

9\2 = INT(9/2) = 4

Mainwin Calculator (Triangle)
G-ZERO Mill v4.0 comes with a calculator to assist you calculate unknowns in triangles, as well as trigo-
nometry and basic algebra.  To open the Mainwin Calculator, select  Triangle from the Tools pull-down
menu, or use the keyboard shortcut Ctrl+T.

Triangle functions
Mainwin Calculator offers seven situations for you to calculate
unknown values in triangles:

2 sides known
1 side, 1 angle known
3 sides known
adjacent side-side-angle known
adjacent side-angle-side known
adjacent angle-side-angle known
adjacent angle-angle-side known

Just enter 2 or 3 values of a triangle (sides or angles), and the calculator will give you the values for the rest
of the sides and/or angles.  You can use the drag-and-drop method to select any one of these results and
drop it on the dialog bar of G-ZERO application window and use it as the answer to your programming
question.

Math functions
Functions available are: ABS, SIN, COS, TAN, ATAN, LOG,
SQRT, INT, FRAC, CIEL, FLOOR, LOG10, EXP.
Use the bottom Edit bar to type your Math function.  After you
press the Enter key, the result will appear in the same Edit bar.
Use the drag-and-drop method to select the result and drop it on
the dialog bar of G-ZERO application window to use it as the
answer to your programming question.
Math functions need to be typed in upper case; they work in
radians and the results are also given in radians (not decimal).
Use Math functions in  Mainwin Calculator only; do not use them directly in the dialog bar of G-ZERO
application window.

Math operators
Operators available are: + plus > greater

- minus < smaller
* multiply <> not equal
/ divide & and
\ integer divide | or

Results of all math calculations can be dragged and dropped into the dialog bar of G-ZERO application
window to use it as the answer to your programming question.
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Special Keys
Positioning
Page Up ..............Up one screen
Page Down .........Down one screen
Up Arrow ...........Up one line
Down Arrow.......Down one line
Home ..................To beginning of source program
End .....................To end of source program
Ctrl+L .................Goto a specific line (key in line number)
Ctrl+F .................Find
Ctrl+S .................Find next

Programming
Esc ......................Undo last source line.  Undo last value entered if programming a command
O ......................... (Letter O).  Override:  forces G-ZERO to accept values out of normal range
Any Letter(s) ......Comment
% ........................Machine readable comment or post command (key in ONLY machine readable comments

after the % symbol to avoid an alarm on your machine).  See %Command section.
# .........................Calls data or program from another file
F1 or ? ................Help on command currently programming.  Main Help menu if you are not in the middle

of programming a command

Tools
Ctrl+T.................Mainwin calculator (Triangle)
F1 .......................Help
F8 .......................Sketch/Machine (Option)
F9 .......................CAD Reader
F11 .....................Mouse Rough
F12 .....................Post Process

Viewport
F2 .......................Part view
F3 .......................Tool view
F4 .......................Slinky mode
F5 ....................... Iso view
F6 .......................Solid view
F7 .......................Show/Hide viewport
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Special Words
Some words entered as Comments perform specific functions.  These reserved words are:

COLOR
Type the word COLOR followed by a number to change the color of your graphics from the current line
until the the next Tool or COLOR comment.  This is quite helpful when a tool will be used for several
different layers of your part.
Example:  COLOR 1  will draw in blue.

0 Black 4 Red 8 Gray 12 Light Red
1 Blue 5 Magenta 9 Lilght Blue 13 Light Magenta
2 Green 6 Brown 10 Light Green 14 Yellow
3 Cyan 7 White 11 Light Cyan 15 Hi-intensity White

ZTOP
Enter a ZTOP comment line right before the MAT’L command to show material above the top of your part
(usually Z0).
Example:  We are going to flycut (0.02”) off the material.  In order to show in
the viewport 0.02” of material to be cut, we need to enter ZTOP.02 right before
the MAT’L command.

1 ZTOP.02
2 MAT’L xmin0 xmax4 ymin0 ymax3 thk.13 type0=ALUMALOY

Note:  Only solid view (F6) shows ZTOP in the viewport.

ZTOP.02

THK.13
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% Commands
% ........................Machine readable comment or post command (key in ONLY machine readable comments

after the % symbol to avoid an alarm on your machine).
%+ ......................Continue comment from previous line, or add G-code to line above.

General
%( comment ) .....Send man-readable comment to machine.  Example:  %(CARBIDE ENDMILL)
%O .....................Set program number (place before the first Tool).  Example:  %O0234  sets program

number to be “0234”
%STARTSUB ....Set subprogram starting number - override location of SUB.

Example:  %STARTSUB 3000   places SUB in the 3000 area of memory to avoid
collisions  (post processors for most Fanuc-/Yasnac-type controllers put SUBs in the
6000, 6500 and 7000 area)

%N_ S_ ..............Output whole line without processing.  Example:  %N25 S20  (CNC sees this, G-ZERO
does not)

%OFF .................Following source lines are for profile definition only.
%ON ..................Cancels %OFF.

Tool change
Note:  %Anything  can be programmed in the TOOL *** comment area.
%TC X_ Y_ .......Set tool change location for all tools.  Example:  %TC X12.1 Y6.6  forces tool change at

location x=12.1 and y=6.6 (machines normally change tools wherever the last cut ended).
%TCX ................Set var #69 in UNIM.
%TCY ................Set var #70 in UNIM.
%TCZ .................Set var #71 in UNIM.
%M0 ...................Set var #56 in UNIM.
%S0 ....................Set var #55 in UNIM.

Feedrate
%F ......................Override G-ZERO automatic feedrate selection from that point in the source program to

the next tool change.  Example:  %F10  sets the feed at 10 inches per minute.
%F99.99  unlocks a feed and lets G-ZERO start its automatic feedrate selection again.

%F- .....................Force deceleration for radii (percentage of feedrate).  Example:  %F-25  slows down 25%
around circles.
%F-0  shuts off radius deceleration.

%FMAX .............Set maximun allowable feedrate.  Example:  %FMAX25  limits feedrate to 25 ipm.
%CHIP ...............Override feedrate and give it in chipload.  Example:  %CHIP.001  calculates feedrate

from .001 chipload.

Spindle speed
%S ......................Override G-ZERO automatic spindle speed selection.  Example:  %S2500 sets the spindle

at 2500 rounds per minute.
%SMAX .............Set maximum allowable rpm for all tools.  Program before first tool.  Example:

%SMAX1200  limits spindle to 1200 rpm.
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Coolant
%COOL OFF .....Turn coolant off.
%COOL ON .......Turn coolant back on again.
%COOLIN .........Set coolin flag: var #30.
%COOLHI .........Set var #28.

Viewport display  (F6 - Solid mode only)

In TOOL comment only  (See Solid Verification section):
%#TL .................Set tool length.  Example:  %#TL=1.5  sets tool length to 1.5 inches.
%#TT .................Set tool taper.  Example:  %#TT=5  sets tool taper to 5°.
%#TA .................Set tool angle.  Example:  %#TA=45  sets tool angle to 45°.

Post
%#POST ............Resets .P file variables.  Example 1:  %#POST(21)=1  turns on metric.

Example 2:  %#POST(52)=1  turns on tracing.
%#ARG ..............Reset post global variables.  Example:  %$ARG(101)=HI MOM  resets tool comment

string.
%G0ALF ............Tell FADAL post to skip canned lettering cycle.
%JSHIFT ...........Set var #53.  It is usually used in G10 areas of post.  Used to base G54 offsets at 55, 56,

etc.
%PALLET ..........Set var #35.

Math
%POLAR ON ....Switch to polar coordinate system, where XY points become R (radius), THETA (de-

grees).
%POLAR OFF ...Turn off polar coordinate system.

Stepover
%STEP ...............Set stepover amount or percentage for RECT and ROUND.

Example 1:  %STEP65  steps 65%
Example 2:  %STEP.002  steps 0.002 inches.

Rapid
%ZBUFF ............Set the distance between zrap and top of part for MILL passes calculation.

Example:  %ZBUFF.05  tells passes how close to rapid: 0.05”.
%WSAFE ...........Set var #60.
%ZSAFE ............Set var #43.  it is used in B area for safe rapid up or down.

Station
Note: Station option is sold separately.  See Station manual.
%ORDER ...........Replace MULTIPLY usage with STATION to link stations.

Example:  %ORDER 1A,2B,3A,4B
%+ORDER ........Continuation of %ORDER command just above it.
%BCOPY ...........Tell station to copy on other side(s) of stone.  Example:  %BCOPY2  to copy on 2 sides

of stone.
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Wrap
Note:  Wrap option is sold separately.  See Wrap manual.
%WRAP ....................... Normal wrap.  Example:  %WRAP Y RAD1.3 STP.05 ZC0  wraps around the Y

axis, being the cylinder radius 1.3” and its center at Z=0, and tool step=.05”.
%WRAP CONTROL ... Wrap control: sets wrap control curve to define part wall for simultaneous XYZA

motion.  Example:  %WRAP CONTROL STP.05  wraps around the X axis with a
tool step over of 0.05”.  Program right before control curve definition.

%WRAP LOCKED...... Wrap locked:  locks 4th axis at a certain degree to project onto cylinder without 4th
axis motion.  Example:  %WRAP RAD1.2 STP.05 LOCK120  wraps around the X
axis locking the 4th axis at 120°.

%WRAP OFF .............. Cancel Wrap settings.

031501 mill4-ref-basic.p65
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